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Regulatory Compliance

Thermo Fisher Scientific performs complete testing and evaluation of its products to ensure full compliance with 
applicable domestic and international regulations. When the system is delivered to you, it meets all pertinent 
electromagnetic compatibility (EMC) and safety standards as described in the next section or sections by product name.

Changes that you make to your system may void compliance with one or more of these EMC and safety standards. 
Changes to your system include replacing a part or adding components, options, or peripherals not specifically 
authorized and qualified by Thermo Fisher Scientific. To ensure continued compliance with EMC and safety standards, 
replacement parts and additional components, options, and peripherals must be ordered from Thermo Fisher Scientific 
or one of its authorized representatives.

EMC Directive 2004/108/EC

EMC compliance has been evaluated by CTC Analytics for the HTC PAL™ autosampler.

Low Voltage Safety Compliance

Low Voltage Safety Compliance has been evaluated by CTC Analytics for the HTC PAL autosampler.

This device complies with Low Voltage Directive 2006/95/EC and harmonized standard EN 61010-1:2001, 
IEC 61010-1:2001, ANSI/UL 61010 A-1:2004, CAN/CSA 22.2 61010-1:2004.

FCC Compliance Statement

IEC 61326-1:2005 IEC 61326-2-6:2005

EN 61326-1:1997, A1:1998 CISPR 22:2005, A1:2005, A2:2006

FCC Class A, CFR 47 Part 15:2003

THIS DEVICE COMPLIES WITH PART 15 OF THE FCC RULES. OPERATION IS SUBJECT TO 
THE FOLLOWING TWO CONDITIONS: (1) THIS DEVICE MAY NOT CAUSE HARMFUL 
INTERFERENCE, AND (2) THIS DEVICE MUST ACCEPT ANY INTERFERENCE RECEIVED, 
INCLUDING INTERFERENCE THAT MAY CAUSE UNDESIRED OPERATION.

CAUTION Read and understand the various precautionary notes, signs, and symbols contained inside 
this manual pertaining to the safe use and operation of this product before using the device.



Notice on Lifting and Handling of
Thermo Scientific Instruments

For your safety, and in compliance with international regulations, the physical handling of this Thermo Fisher Scientific 
instrument requires a team effort to lift and/or move the instrument. This instrument is too heavy and/or bulky for one 
person alone to handle safely.

Notice on the Proper Use of
Thermo Scientific Instruments

In compliance with international regulations: This instrument must be used in the manner specified by Thermo Fisher 
Scientific to ensure protections provided by the instrument are not impaired. Deviations from specified instructions on 
the proper use of the instrument include changes to the system and part replacement. Accordingly, order replacement 
parts from Thermo Fisher Scientific or one of its authorized representatives.

Notice on the Susceptibility 
to Electromagnetic Transmissions

Your instrument is designed to work in a controlled electromagnetic environment. Do not use radio frequency 
transmitters, such as mobile phones, in close proximity to the instrument.

For manufacturing location, see the label on the instrument.



WEEE Compliance
This product complies with the European Union’s Waste Electrical & Electronic Equipment (WEEE) Directive
2002/96/EC. It is marked with the following symbol: 

Thermo Fisher Scientific has contracted with one or more recycling or disposal companies in each European Union 
(EU) Member State, and these companies should dispose of or recycle this product. For further information, go to 
www.thermoscientific.fr/rohs. 

WEEE Konformität
Dieses Produkt entspricht der EU Waste Electrical & Electronic Equipment (WEEE) Richtlinie 2002/96/EC. Es ist 
mit dem folgenden Symbol gekennzeichnet: 

Thermo Fisher Scientific hat Vereinbarungen mit Verwertungs-/Entsorgungsfirmen in allen EU-Mitgliedsstaaten 
getroffen, damit dieses Produkt durch diese Firmen wiederverwertet oder entsorgt werden kann. Weitere 
Informationen finden Sie unter www.thermoscientific.de/rohs. 

http://www.thermoscientific.fr/rohs
http://www.thermoscientific.de/rohs


Conformité DEEE
Ce produit est conforme avec la directive européenne (2002/96/EC) des  Déchets d'Equipements Electriques et 
Electroniques (DEEE). Il est marqué par le symbole suivant: 

Thermo Fisher Scientific s'est associé avec une ou plusieurs sociétés de recyclage dans chaque état membre de l’Union 
Européenne et ce produit devrait être collecté ou recyclé par celle(s)-ci. Pour davantage d'informations, rendez-vous 
sur la page www.thermoscientific.fr/rohs.

http://www.thermoscientific.fr/rohs
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Preface

This guide describes how to connect a CTC™ Thermo PAL™ autosampler to other devices in 
the liquid chromatography/mass spectrometry (LC/MS) system and how to control the 
autosampler from a Thermo Scientific™ MS data system, such as Thermo Xcalibur™. 

ThermoPAL, one of the device drivers provided on the Thermo LC Devices DVD, is the 
device driver that enables the Xcalibur data system to control the autosampler.

 To suggest changes to the documentation or to the Help

Complete a brief survey about this document by clicking the button below. 
Thank you in advance for your help.

Contents

• Related Documentation 

• System Requirements 

• Supported Firmware Versions 

• Cautions and Special Notices 

• Contacting Us 

http://www.surveymonkey.com/s/PQM6P62
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Related Documentation
In addition to this guide, the Thermo PAL autosampler software includes Help. 

 To view product manuals

From the Microsoft™ Windows™ taskbar, do the following: 

• For an LC instrument controlled by a Thermo software application, choose Start > 
All Programs > Thermo Instruments > Manuals > LC Devices > CTC. 

• For the Xcalibur manual set, choose Start > All Programs > Thermo Xcalibur > 
Manuals > Xcalibur. 

For access to the application Help, follow this procedure. 

 To view application-specific Help

• From the Thermo Xcalibur Instrument Setup window, choose Help > Thermo Pal 
Help. 

• If information about setting parameters is available for a specific view, page, or dialog 
box, click Help or press the F1 key for information about setting parameters. 

For more information, visit www.thermoscientific.com. 

http://www.thermoscientific.com
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System Requirements
Ensure that the system meets these minimum requirements.

(Windows 7 only) If you receive a server failure error when you try to open the Xcalibur 
Instrument Setup window, follow the next procedure. 

 To resolve a server failure for the Xcalibur data system

1. Verify that the installed versions of Foundation platform and LC Devices are compatible 
(see System Requirements). 

2. If the installed LC Devices software is compatible with Foundation, go to step 3. If it is 
not compatible, do the following: 

a. Use the Windows Control Panel to uninstall all of the modules from LC Devices. 

b. Install the compatible version of LC Devices. 

c. Restart the data system computer. 

IMPORTANT   Before you install the device driver, ensure that the data system computer 
has a compatible version of the Thermo Foundation™ platform as noted in the Thermo LC 
Devices x.x.x Release Notes.

System Minimum requirements

Computer • 2 GHz processor with 1 GB RAM 
• DVD drive 
• 80 GB available on drive C 
• Video card and monitor capable of 1280 × 1024 resolution 
• NTFS format 

Software • Adobe™ Reader™ 9.0 

• Microsoft Windows operating system: 

 Windows 7 Professional (32-bit and 64-bita) 

 Windows XP Workstation SP3 

• Thermo Scientific software: 

aLC Devices 2.8.0 and later are compatible with Windows 7, 32-bit and 64-bit. 

LC Devices Foundation 

2.6.0 and later 1.0.2 SP2 and later

2.5.0 SP3 1.0.2 SP2

2.5.0 SP1 or SP2 2.0 

2.5.0 1.0.2 SP2 
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3. If the installed LC Devices is compatible with Foundation, do the following: 

a. Open the Windows Control Panel. 

b. In the top Search box, type Change User Account Control Settings, and then select 
this link to open the User Account Control Settings dialog box. 

c. Move the slider to the Default position (Figure 1).

d. Click OK. 

Figure 1. User Account Control Settings dialog box

Supported Firmware Versions
LC Devices supports firmware versions 2.4.0, 2.5.2, 4.1.2, and 4.1.3 for the Thermo PAL 
autosampler. 

Slider set at the 
Default position
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Cautions and Special Notices
Make sure you follow the cautions and special notices presented in this guide. Cautions and 
special notices appear in boxes; those concerning safety or possible system damage also have 
corresponding caution symbols. 

This guide uses the following types of cautions and special notices. 

Contacting Us
There are several ways to contact Thermo Fisher Scientific for the information you need. 

 To contact Technical Support

 To contact Customer Service for ordering information

CAUTION  Highlights hazards to humans, property, or the environment. Each CAUTION 
notice is accompanied by an appropriate CAUTION symbol. 

IMPORTANT      Highlights information necessary to prevent damage to software, loss of 
data, or invalid test results; or might contain information that is critical for optimal 
performance of the system.

Note  Highlights information of general interest.

Tip  Highlights helpful information that can make a task easier.

Phone 800-532-4752

Fax 561-688-8736

E-mail us.techsupport.analyze@thermofisher.com

Phone 800-532-4752

Fax 561-688-8731

E-mail us.customer-support.analyze@thermofisher.com

Web site http://www.thermoscientific.com/en/support-landing/support.html

mailto:us.techsupport.analyze@thermofisher.com
mailto:us.customer-support.analyze@thermofisher.com
http://www.thermoscientific.com/en/support-landing/support.html
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 To copy manuals from the Internet

Go to mssupport.thermo.com, agree to the Terms and Conditions, and then click 
Customer Manuals in the left margin of the window. 

 To suggest changes to the Help

• Fill out a reader survey online at www.surveymonkey.com/s/PQM6P62.

• Send an e-mail message to the Technical Publications Editor at 
techpubs-lcms@thermofisher.com. 

http://mssupport.thermo.com
http://www.surveymonkey.com/s/PQM6P62
mailto:techpubs-lcms@thermofisher.com
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Getting Connected

The CTC Thermo PAL is a high-throughput autosampler manufactured by CTC Analytics 
and supplied by Thermo Fisher Scientific. For high-throughput LC/MS applications, use the 
PAL autosampler, a Thermo Scientific or an Agilent™ liquid chromatography (LC) pump, 
and a Thermo Scientific mass spectrometer (MS). 

This chapter describes the contact closure connections between the PAL autosampler, one or 
two Thermo Scientific LC pumps or an Agilent pump, a Thermo Scientific mass 
spectrometer, and the Xcalibur data system computer. For information on how to set up the 
PAL autosampler, refer to the CTC Analytics PAL System User Manual. 

Ordering Information
Thermo Fisher Scientific supplies these cables with the Thermo PAL autosampler: 

• Serial communication cable that connects the autosampler to the data system computer 

• Contact closure cable that connects the autosampler to the Thermo Scientific LC pump 
and Thermo Scientific mass spectrometer 

CAUTION  Follow all of the recommendations given in the Safety Information section of 
the CTC Analytics PAL System User Manual. The Safety Information section includes 
information on the autosampler’s electrical hazards, lithium battery, and safety labels.

Contents

• Ordering Information 

• Setting Up an LC/MS System with the Autosampler 

• Connecting the Thermo PAL Autosampler to the Data System 
Computer 

• Connecting the Contact Closure Cables 
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To order the HTC PAL or HTS PAL autosampler from Thermo Fisher Scientific, see Table 1. 

Table 2 lists the contact closure cables used to connect an Agilent pump to a Thermo 
Scientific mass spectrometer and the autosampler. You can order the DB15 connector × 15 
wire cable from Agilent or Thermo Fisher Scientific. 

Setting Up an LC/MS System with the Autosampler
Typical stackable setups include placing the autosampler on top of the two pumps, in a 
dual-pump setup, and to the left of the mass spectrometer. Ensure that the stackable area for 
the autosampler is level, and that system cables behind the autosampler have adequate space.

For information on how to assemble the Thermo PAL autosampler and connect the solvent 
lines, refer to the CTC Analytics PAL System User Manual. 

Figure 2 shows the front view of the Thermo PAL autosampler. During installation, the 
Thermo Fisher Scientific field service engineer connects the following: 

• LC system to the mass spectrometer 

• Solvent lines from the injection valve to the LC pump and the Thermo Scientific mass 
spectrometer 

Table 1. Thermo PAL ordering information

Description Part number

HTC PAL OPTON 13009

HTC PAL with the 98 × 2 mL tray holder OPTON 13010

HTS PAL OPTON 13008

Table 2. Contact closure cables used to connect an Agilent pump

Description Supplier Part number

DB15 connector × 15 wire cable Thermo Fisher Scientific 00012-27716

DB15 connector × 15 wire cable Agilent G1103-61611

PAL Interface Cable for APG Remote 
DB15 connector × DB9 connector cable 

CTC Analytics CBL 7890

CAUTION  To prevent damage to the injection unit during operation, place the 
autosampler on a level surface. 
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Figure 2. PAL autosampler (supplied by Thermo Fisher Scientific)

Courtesy of CTC Analytics

Control terminal

Syringe

Injection unit
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Connecting the Thermo PAL Autosampler to the Data System 
Computer

The Thermo PAL autosampler communicates with the data system computer through the 
supplied RS-232 serial communication cable.

 To connect the autosampler to the data system computer

Using the RS-232 serial cable supplied with the autosampler, connect the SER 1 port on 
the back of the autosampler to the serial port on the back of the data system computer 
(Figure 3 and Figure 4). 

Figure 3. Data system connection (firmware 2.5.2)

POWERINTERFACE SER2SER3 SER1WASH
STATION

BUZZERLEDAUX

Data system 
computer

 Autosampler

DB9 to DB9 
serial cable
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Figure 4. Data system connection (firmware 4.1.2)

Connecting the Contact Closure Cables
During an injection cycle, the Thermo PAL autosampler sends and receives electrical signals. 
To start an injection cycle, the autosampler must receive a signal from the LC pump. When 
the autosampler completes an injection cycle, it sends a signal back to the LC pump. For more 
information about interfacing the autosampler with other devices, refer to the CTC Analytics 
PAL System User Manual (Interfacing the PAL to Other Devices section).

This section describes how to hardwire one or two LC pumps and a Thermo Scientific mass 
spectrometer to the autosampler for contact closure. 

To make the contact closure connections, follow the procedure for your LC/MS system:

• Making Contact Closure with Thermo Scientific Devices

• Connecting the Start Pump to the Sample Pump in a Dual-Pump System

• Dual-pump setup with two Accela Pumps

AUX 2 POWER FUSEAUX 1INTERFACE 2INTERFACE 1TERMINAL SER1 LAN MODBUS BUZZER WASH
STATION

L
E
D

Autosampler

Data system 
computer

DB9 to DB9 
serial cable
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Making Contact Closure with Thermo Scientific Devices

The accessory kit supplied by Thermo Fisher Scientific contains the contact closure cables 
that you need to connect the Thermo PAL autosampler to an LC/MS system with one or two 
Thermo Scientific LC pumps and a Thermo Scientific mass spectrometer.

Figure 5 shows the Thermo Single Configuration cable assembly that you use to connect one 
LC pump and a Thermo Scientific mass spectrometer to the autosampler. The cable assembly 
consists of a DB15 connector with two 2-pin legs. One leg connects to the LC pump, and the 
other leg connects to the mass spectrometer. During the installation of the LC/MS system, a 
Thermo Fisher Scientific field service engineer uses the appropriate mini COMBICON™ 
connectors to complete the contact closure cable assembly, and then connects the assembly to 
the appropriate pins on the LC pump or LC pumps and the mass spectrometer. 

Figure 5. Contact closure cable for LC/MS with one Thermo Scientific LC Pump

 To connect the contact closure cable to the LC pump and the MS

1. Connect the DB15 connector of the contact closure cable to the DB15 port on the back 
of the autosampler. 

The port label depends on the autosampler model (see Table 3).

Table 3. PAL contact closure port

PAL model Port marking

HTC, LC INTERFACE

HTS INTERFACE 1

Cbl Thermo Single Config. 

300 cm
(10 ft)

Clear
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2. Using an 8-pin COMBICON connector, connect one leg of the contact closure cable to 
the appropriate pins on the back panel of the Thermo Scientific LC pump (see Table 4).

3. Using a 2-pin COMBICON connector, connect the other leg of the contact closure cable 
to the Start in pins on the Thermo Scientific MS.

Figure 6 shows the contact closure connection between the autosampler and a Thermo 
Scientific LC pump, and Figure 7 on page 9 shows the contact closure connection between 
the autosampler and a Thermo Scientific mass spectrometer. (Figure 6 is for firmware 2.5.2 
and Figure 7 is for firmware 4.1.2.) 

Table 4. Contact closure cable connection to Thermo Scientific pump

 Pump model Clear wire Black wire

Accela Pump GRAD START (pin 4) GND

Surveyor LC Pump Plus PROG. START (pin 4) GND

Surveyor MS Pump Plus GRAD START (pin 8) GND
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Figure 6. Contact closure connections to a Thermo Scientific LC pump and MS (firmware 2.5.2)
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Figure 7. Contact closure connections to a Thermo Scientific LC pump and MS (firmware 4.1.2)
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Connecting the Start Pump to the Sample Pump in a Dual-Pump System

In a dual-pump system, the start pump triggers the sample pump. 

To connect the start pump to the sample pump, you can use the contact closure cable that 
CTC Analytics supplies, or you can use one insulated electrical wire to connect the ground 
pins and one insulated electrical wire to connect the GRAD START or PROG. START pins.

Figure 8 shows the contact closure cable that you can order from CTC Analytics. 

Figure 8. Contact closure cable (supplied by CTC Analytics) used to connect two LC pumps

 To make contact closure for a dual-pump system

1. Connect the DB15 connector of the Thermo Single Config cable to the INTERFACE 1 
or INTERFACE port on the back panel of the autosampler.

2. Connect one of the 2-pin legs of the Thermo Single Config cable to the start pump. 

3. Connect the other 2-pin leg of the Thermo Single Config cable to the Thermo 
Scientific MS.

4. Connect the start pump to the sample pump:

• Connect the start pump ground pin to the sample pump ground pin.

• Connect the GRAD START or PROG. START pin on the start pump to the GRAD 
START or PROG. START connection on the sample pump. 

Table 4 on page 7 lists the pin assignments of the Accela Pump, the Surveyor MS 
Pump Plus, and the Surveyor LC Pump Plus.

Figure 9 shows two Accela Pumps connected together for contact closure.

Cbl Thermo Dual Config. 

100 cm
(39 inches)
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Figure 9. Dual-pump setup with two Accela Pumps
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Making Contact Closure with the Autosampler, an Agilent Pump, and a Mass 
Spectrometer

To make contact closure between the autosampler and an Agilent pump and between an 
Agilent pump and a Thermo Scientific mass spectrometer, you must have the following 
cables:

• PAL interface cable (supplied by CTC or Agilent) for an Agilent pump (Figure 10)

• External contact trigger cable supplied by Thermo Fisher Scientific (Figure 11)

 To make contact closure between the autosampler, an Agilent Pump, and a Thermo 
Scientific MS

1. Using the PAL interface cable (Figure 10), connect the Agilent pump to the autosampler 
as follows (Figure 12 on page 14 [firmware 2.5.2] and Figure 13 on page 15 [firmware 
4.1.2]): 

• Connect the DB15 connector to the INTERFACE (HTC) or INTERFACE 1 
(HTS) port on the back panel of the Thermo PAL autosampler. 

• Connect the DB9 connector to the REMOTE port on the back panel of the Agilent 
pump.

Figure 10. PAL interface cable for an Agilent pump (supplied by CTC Analytics)

2. Using the external contact trigger cable (Figure 11), connect the Agilent pump to the 
mass spectrometer (Figure 12 on page 14 [firmware 2.5.2] and Figure 13 on page 15 
[firmware 4.1.2]):

• Connect the DB15 connector to the RELAY CONTACTS port on the back of the 
Agilent pump. 

For information on how to install the external contact board, refer to the Agilent xxxx 
Series Getting Connected Guide, where xxxx is your specific Agilent LC system.

• Connect the white wire to the Start In pin and the brown wire to ground on the MS. 
Secure the remaining 13 wires to the cable with duct tape.
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Figure 11. External contact trigger cable (supplied by Thermo Fisher Scientific)
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Figure 12. Contact closure with an Agilent pump, the autosampler, and a Thermo Scientific MS (firmware 2.5.2)
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Figure 13. Contact closure with an Agilent pump, the autosampler, and a Thermo Scientific MS (firmware 4.1.2)
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2

Getting Started

This chapter describes how to add the autosampler to the Xcalibur instrument configuration, 
how to specify the available tray types, and how to specify the injection parameters for the 
autosampler from the Xcalibur data system.

Configuring the Thermo PAL Autosampler
The ThermoPAL device driver provides control of the autosampler from the Xcalibur data 
system. To control the autosampler from the data system, add the autosampler to the Thermo 
Foundation Instrument Configuration window and specify its configuration options. 

 To add the autosampler to the Foundation instrument configuration

1. Turn on the autosampler. 

2. From the Microsoft Windows taskbar, choose Start > All Programs > Thermo 
Foundation x.x > Instrument Configuration to open the Thermo Foundation 
Instrument Configuration window (Figure 14). 

Contents

• Configuring the Thermo PAL Autosampler 

• Using the Autosampler Control Terminal 

• Specifying the Instrument Method Parameters
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Figure 14. Thermo Foundation Instrument Configuration window

3. Under Available Devices, double-click the autosampler icon to add it to the Configured 
Devices area. 

Use the Pal Configuration dialog box to select the PC Com port where the autosampler is 
connected, specify macros to import, and select sample trays or stacks. 

 To specify the configuration options for the autosampler

1. Follow the procedure “To add the autosampler to the Foundation instrument 
configuration” on page 17. 

2. In the Instrument Configuration window, under Configured Devices, double-click the 
autosampler icon, and then do the following on the displayed page (Figure 15). 
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Figure 15. Pal Configuration dialog box

3. Under Communications, do the following: 

a. In the Com Port list, select the communication port on the data system computer 
that the autosampler connects to. Or, click Auto Select. 

b. If the autosampler is already connected to the data system computer, click Check to 
verify the connection. 

4. Under Look Ahead Injections, to shorten the time between injections, select the Enable 
check box. 

5. Under Method Template\Macro Editor, to make the Method Template and Macro Editor 
dialog boxes available in the Instrument Setup window, select the Enable check box. 

6. Under Cycle Composer Macro Importer, import the macros that you plan to use to create 
injection methods as follows: 

a. In the Import Path box, type the complete path to the location of the macros. Or, 
click Browse to locate the directory that contains the appropriate macros. 

b. In the Overwrite Existing Macros list, select one of the following: 

• Never—The autosampler does not import the specified macro if it has the same 
file name as an existing macro. 

Note  The auto-select feature works only if the autosampler is connected to the 
data system computer and is turned on. 

Tip  Do not modify or delete a sequence while the data system is running with the 
Look Ahead Injections enabled. Use the stop function to finish the current injection 
before you modify or delete a sequence. 
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• Ask—The autosampler asks you if you want to overwrite existing macros. 

• Always—Imported macros overwrite existing macros. 

c. Click Import. 

7. Under Active Trays, select the trays that you want to use. 

You can use trays that have a Yes in the Allow Use column. Clicking the tray name clears 
the Allow Use cell and removes the tray from the list of available trays in the Xcalibur data 
system. 

8. Click OK. 

9. Configure the other instruments in the LC/MS system, such as the LC pump and the 
mass spectrometer. 

10. In the Thermo Foundation Instrument Configuration window, click Done. 

Table 5 lists the parameters for the Pal Configuration dialog box. 

IMPORTANT  Use the autosampler control terminal to specify the tray information. 
You can change the tray information when you control the autosampler from the 
Xcalibur data system, but these changes are temporary. When you close and reopen 
the Xcalibur data system, the tray information resets to the autosampler control 
terminal settings. 

Table 5. Pal Configuration dialog box parameters (Sheet 1 of 2)

Parameter Description

Communications

Com Port Select the computer port where you plug the autosampler 
communication cable. 

Auto Select Instructs the system to automatically determine the computer 
port that connects to the autosampler through the 
autosampler communication cable. 

Check Instructs the system to verify the computer port that connects 
to the autosampler through the autosampler communication 
cable. 

Look Ahead Injections

Enable Select this check box to enable Look Ahead Injections. 

When enabled, the autosampler sets up for the next injection 
during the current run. The setup for the next injection 
involves carrying out the steps up to, but not including, the 
injection. 

Method Template \ Macro Editor
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Using the Autosampler Control Terminal
For general information about using the autosampler control terminal, refer to the CTC PAL 
System User Manual. 

To select the sample trays and to change the default pulse time setting to 4.0 seconds, follow 
these procedures: 

• Selecting the Tray Type

• Changing the Pulse Time Setting

Enable Select this check box when you want the Method Template 
and Macro Editor to be accessed through Instrument Setup. 
Ensuring the check box is clear prevents access to the Method 
Template and the Macro Editor.

Cycle Composer Macro Importer

Import Path Enter the path to the Cycle Macro to be imported. 

Overwrite Existing Macros Select Never, Ask, or Always. 

The selection determines if existing macros are to be 
overwritten when a new macro is imported. 

Import Import the chosen macro. 

Browse Search through files and folders to find a macro. 

Active Trays

Tray Name Hardware configured tray names. 

Stack Stack location of a given tray name. 

Allow Use Click to switch between Yes and blank. 

• “Yes” means that the PAL system can access a given tray 
for obtaining samples (use is allowed). 

• A blank means that the PAL system cannot access the tray 
for obtaining samples (that is, use is not allowed). 

Table 5. Pal Configuration dialog box parameters (Sheet 2 of 2)

Parameter Description
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Selecting the Tray Type

 To select the tray type

1. On the Job Queue screen, select Menu by pressing the F1 key (Figure 16).

Figure 16. Autosampler control terminal with the Job Queue screen displayed

2. From the Menu screen, open the Tray screen as follows: 

a. Rotate the outer knob to move the cursor bar (highlight) to Setup, and then press the 
inner knob (button).

b. Rotate the outer knob to move the cursor bar to Objects, and then press the inner 
knob (button).

c. Rotate the outer knob to move the cursor bar to Trays, and then press the inner knob 
(button). 

The Trays screen lists the available trays. 

3. Select a tray as follows: 

a. Rotate the outer knob to move the cursor bar to the tray that you want, and then 
press the inner knob (button). 

The screen now shows the Tray Type. 

b. Make the Tray Type active by pressing the inner knob (button) again. 

The Tray Type is highlighted. 
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Job
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c. Rotate the outer knob to select the tray type. Select NONE if no tray is present 
(rotate the outer knob until NONE appears as the Tray Type).

d. Press the inner knob (button) to make the selection.

4. Repeat step 3 for all the trays to be used. 

5. Return to the Job Queue screen by pushing the F4 key (Home) on the control terminal.

Changing the Pulse Time Setting

To control LC systems with a Thermo Scientific LC pump and an autosampler from the 
Xcalibur data system, you must change the default pulse time setting for the autosampler from 
2 to 4 seconds. The pulse time is the length of time that the autosampler sends an output 
signal after it makes an injection. The LC pump receives this output signal through the 
contact closure cable. 

Change the pulse time setting to 4.0 seconds from the Injected screen (Figure 17).

Figure 17. Menu path to Injected screen

IMPORTANT  If your LC system contains a Thermo Scientific LC pump and an 
autosampler, you must change the autosampler’s default pulse time setting. If you leave 
the default pulse time set to 2 seconds, the status of the LC pump remains at waiting for 
contact closure after you make an injection. 
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 To change the pulse time setting

1. Open the Injected screen as follows:

a. On the Job Queue screen, press the F1 key to select Menu (Figure 16 on page 22).

b. Rotate the outer knob to move the cursor bar (highlight) to Setup, and then press the 
inner knob (button). 

c. Rotate the outer knob to move the cursor bar (highlight) to Objects, and then press 
the inner knob (button). 

d. Rotate the outer knob to move the cursor bar (highlight) to Out Signals, and then 
press the inner knob (button). 

e. Rotate the outer knob to move the cursor bar (highlight) to Injected, and then press 
the inner knob (button) to display the Injected screen (Figure 17 on page 23). 

2. Rotate the outer knob to move the cursor bar (highlight) to Pulse Time, and then press 
the inner knob (button) to highlight the time cell.

3. Rotate the outer knob to change the pulse time to 4.0 seconds, and then press the inner 
knob (button) to set this selection as the default. 

4. Press the F4 key (Home) to return to the Job Queue screen. 

Specifying the Instrument Method Parameters
To inject a sample set automatically, you must create an instrument method that contains the 
chromatographic conditions and mass spectrometer data acquisition settings, and then create 
an acquisition sequence that specifies the instrument method and vial location for each run. 

This section describes how to specify the basic instrument method parameters for the 
autosampler. For information on how to create acquisition sequences, refer to the Xcalibur 
Sequence Setup view Help topic. 



 2 Getting Started
Specifying the Instrument Method Parameters

Thermo Scientific Thermo PAL User Guide 25

Creating an Instrument Method

This section provides information about how to create an instrument method.

 To specify the instrument method parameters for the autosampler

1. Choose Start > All Programs > Thermo Xcalibur > Xcalibur, and then click the 
Instrument Setup icon to open the Instrument Setup window. 

2. Click the autosampler icon to open its Instrument Setup window. 

3. Click the Method Setup tab to open the Method Setup page (Figure 18). 

Figure 18. Method Setup page for the autosampler (before you select a template)

4. Under Template Selection, click Browse to open the Browse for Folder dialog box, and 
then browse to the following folder that contains the autosampler methods (.pme 
extension): 

drive:\Thermo\Instruments\LC Devices\ThermoPAL\PAL\Methods 

Note  The Instrument Setup window might take several seconds to open. If you 
receive a server failure error, follow the instructions on page xi. 
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5. In the Template list, select a template that represents the task that you want to do. 

The autosampler comes with these templates: 

• Thermo PAL.pme autosampler (comprised of three templates):

– Multi Step LC Injection.pme 

– Single Step LC Injection.pme 

– Startup-Shutdown.pme 

If you ordered the DLW option with the autosampler, you can also select the DLW 
templates.

In addition to these templates, you can create your own custom templates (see “Using the 
Template Editor to Create Custom Templates” on page 33). When you store a custom 
template in the same folder as the standard templates, the template appears in the 
Template list. 

• DLW Priming_Rev01.pme

• LC-Inj DLW Fast_Rev03.pme

• LC-Inj DLW Standard_Rev03.pme

• Multi Step LC Injection.pme

• Single Step LC Injection.pme

• Startup-Shutdown.pme

CAUTION  Do not use the three DLW templates if you did not order the DLW option 
with your autosampler. Using these templates for the Thermo PAL autosampler 
without the DLW option could cause damage to the instrument and cause the 
injection to not perform any washes at all.

IMPORTANT      If you select a DLW template, make sure the Rear Volume + 
Injection Volume + Front Volume + 2x Airgap is less than the syringe size. Otherwise, 
you receive Error 86 (Syringe Volume Out of Range). 
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Figure 19 shows the macro sequence and the macro variables for the 
Single Step LC Injection template.

Figure 19. Method Setup page on the Instrument Setup window with the LC-Inj template

When you select a template, the macros used by the template appear in the Macro 
Sequence area. When you click on a macro listed in the Macro Sequence area, the 
variables used by the Macro appear in the Variables area.

6. Under Variables, keep the parameters set to the defaults, or type the appropriate values for 
your application. 

7. From the Syringe list, select the syringe size that is installed in the autosampler. 

The default variable settings for the Single Step LC Injection template and the default 
setting of 10 μL in the Recommended Injection Volume box are suitable for a 100 μL 
syringe. Changing the syringe size can change the allowable ranges for the recommended 
injection volume and the variables specified in the LC-Inj macro.

Macro sequence
for the Single Step

LC Injection template

Variable list
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8. Under Recommended Injection Volume, in the Volume (μL) box, type the volume of 
sample that you want the autosampler to inject. 

The allowable injection volume range is based on the syringe size. 
 

9. Under Look Ahead Injections, if the Delay Time (mins) box is available, type the amount 
of time that you want the autosampler to wait after it completes the current injection 
before it starts the next injection. 

During a look ahead injection, the autosampler aspirates the sample for the next injection 
and waits until the end of the current run to inject the sample into the valve. When you 
add a delay time, the autosampler does not begin the next injection cycle immediately 
after completing the current injection cycle. If you enter a delay time longer than the 
method run time, the autosampler begins the next injection at the end of the current run. 
This means that adding a long delay time does not add additional run time to the method 
run time, but it does cancel the effect of using the Look Ahead Injections feature.

10. Specify the acquisition parameters for the other devices of the LC or LC/MS instrument.

11. Save the method: 

a. From the Instrument Setup window, choose File > Save As. 

b. Select a folder in which to store the method, and then type a name for the method in 
the File Name box.

c. Click Save. 

The File Summary Information dialog box appears.

d. (Optional) In the Comment box, type additional information about the method.

e. Click OK.

The Xcalibur data system (or other Thermo Scientific data acquisition applications 
such as LCquan™) stores the method as a METH file in the specified file location. 

IMPORTANT  Make sure that the syringe selection matches the size of the installed 
syringe. 

• If the autosampler is set up to recognize the installed syringe size, an error 
message appears when you download methods that specify a different syringe size. 

• If the autosampler is not set up to recognize the installed syringe and the specified 
syringe size does not match the actual syringe size, the autosampler does not 
inject the specified injection volume.

IMPORTANT  For partial loop injections (variable volume), make sure that the 
recommended injection volume is less than half the sample loop size.

Note  The Look Ahead Injections feature is available if you selected the Enable check 
box in the Look Ahead Injections area of the Pal Configuration dialog box.
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Instrument Setup Parameters

Use the Method Setup page (Figure 19 on page 27) to specify instrument method parameters 
for the autosampler.

Table 6. Method Setup page parameters  (Sheet 1 of 2)

Parameter Description

Template Selection

Template Shows the list of default method templates. 

After you select a template, the Template list changes to a box 
that shows the path to the selected method template file. 

Method Folder Shows the path to the default template folder before you select 
a default method template. 

After you select a method template (in the Template list), the 
Method Folder box disappears. 

Browse Opens the Browse for Folder dialog box to locate the directory 
that contains the method templates. 

After you select a method template (in the Template list), the 
Browse button changes to the New Template button. 

New Template Select this button to bring back the Template list, Method 
Folder box, and Browse button. 

After you select a method template (in the Template list), this 
button appears.

Template Description

Template Description Shows a description of the selected template, which appears in 
the Template box. 

Syringe

Syringe Shows a list of the allowed syringe volumes. 

Select the appropriate syringe volume. 

Macro Sequence

Macro Sequence Shows the sequence of macros that make up the method 
displayed in the Template box. 

Select a macro name to be displayed in the Macro area; its 
variables also appear in the Variables area. 
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Recommended Injection Volume

Volume (μL) When you select an instrument method for use to generate a 
new sequence (on the Xcalibur Home Page), the injection 
volume is set to what is entered in this box. 

For the LCquan application: When “From AS” (From Auto 
Sampler) is specified in the LCquan injection volume 
sequence cell, the autosampler uses the volume in this box 
when you submit the LCquan sequence for acquisition.

Look Ahead Injections

Delay Time (mins) Enter the Delay Time (in minutes) between injections when 
using the Look Ahead feature. 

You enable the Look Ahead Injections option from the Pal 
Configuration dialog box (Figure 15 on page 19). When you 
enable this option, the next Look Ahead Injection is delayed 
the amount of time entered in this box. The delay time 
countdown begins at the completion of any post-injection 
steps, which prevents a sample from being held in the 
injection syringe for the duration of the current run. If the 
entered Delay Time is too long, or the current run ends 
prematurely, the entered Delay Time is canceled and the next 
injection commences in the normal manner. 

Macro

— Shows the name of the selected macro, and the sequence 
number (x) and total number of macros (y) (displayed as 
“name”, x of y). 

This area also lists the variables associated with the macro 
chosen in the Macro Sequence pane.

Variables Shows the variable parameters used by the selected macro. 

• Variables with specific allowed values (discrete variables) 
appear in lists. You may choose the allowed values of the 
discrete variables from those presented in the list. 

• Continuous variables are displayed in boxes. The allowed 
values for continuous variables appear when you hold the 
cursor over the variable’s box. You can type the value for 
the continuous variable in the box. 

Default All This button changes the variables, used in the selected Macro 
Sequence, to their default values.

Table 6. Method Setup page parameters  (Sheet 2 of 2)

Parameter Description
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Viewing the Method Summary
Use the Method Summary page to view the details of the Macro Sequence that makes up an 
autosampler Method or Template. 

The contents of the Method Summary/Template Summary page is read-only.

 To view a summary of the autosampler portion of an instrument method

1. Open the Instrument Setup view for the autosampler (see “Specifying the Instrument 
Method Parameters” on page 24). 

2. Choose File > Open, and then select the instrument method.

3. Click the Method Summary tab.

The Method Summary page appears with a summary of the autosampler parameters for 
the active instrument method (Figure 20). 
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Figure 20. Method Summary page in the Instrument Setup window
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3

Creating Custom Templates and Macros

This chapter describes how to create custom templates and macros. It also includes 
instructions on how to define variables for macro creation. The Thermo PAL autosampler 
provides three standard templates. 

Using the Template Editor to Create Custom Templates
Use the Template Editor page of the Pal Template\Macro Editor window to make a new 
template (a sequence of macros). Each macro in the sequence is made up of variables that you 
may also edit on this page. Table 7 on page 35 lists the parameters for the Template Editor 
page. 

 To create a custom template

1. Open the Template Editor page as follows (Figure 21):

a. Open the Instrument Setup window for the autosampler (see “Specifying the 
Instrument Method Parameters” on page 24). 

b. Choose Pal Auto Sampler > Template\Macro Editor. 

Contents

• Using the Template Editor to Create Custom Templates

• Testing a Custom Template

• Viewing the Template Summary

• Standard Macros

• Using the Macro Editor to Create Custom Macros

• Defining Variables
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Figure 21. Template Editor page on the Pal Template\Macro Editor window

2. (Optional) In the Template Description box, type a description of your custom template.

3. In the Syringe list, select the appropriate syringe size to be specified in the template.

4. Add macros to the template as follows:

a. Under Macro, select a macro from the list. 

The Insert Above and Insert Below buttons become available.

b. Click Insert Above or Insert Below.

The selected macro appears in the Macro Sequence box.

5. Delete macros from the Macro Sequence box by selecting the macro and clicking Delete.

6. Replace a macro in the Macro Sequence box as follows:

a. Under Macro, select a macro from the list.

b. Select the macro that you want to replace in the Macro Sequence box.

c. Click Replace.

7. Save the template:

a. Click Save As.

b. Select a file location, and then type an appropriate name in the File Name box. 

c. Click Save.

The autosampler saves the template with the .pma file extension.
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Table 7. Template Editor page parameters (Sheet 1 of 2)

Parameter Description

Template Description Enter the method description in this box.

Syringe Select the syringe volume from this list.

Macro Sequence

Macro Sequence Shows the macros selected for the method being made in the 
Method Template Editor. 

The macros in this sequence are selected from the Macro list. 
Double-clicking a macro under Macro Sequence displays it in 
the Macro list as described later in this table, along with the 
variables that make up the macro (in the Variables area). 

Insert Above Inserts a macro from the Macro list above the macro selected 
under Macro Sequence. 

Insert Below Inserts a macro from the Macro list below the macro selected 
under Macro Sequence. 

Replace Replaces the macro selected under Macro Sequence with the 
macro that is in the Macro list. 

Delete Deletes the macro selected under Macro Sequence. 

Run Automatically executes the macros that constitute the Method 
(Macro Sequence). 

Step Executes the Method (Macro Sequence) in a stepwise manner. 

Macro

Macro Select individual PAL macros in this list. 

When you select a macro, it is highlighted in blue. The 
sequence number (x) of the selected macro and the total 
number of macros (y) in the Macro Sequence box (“Macro 
x of y”) appear at the top of the Macro list. You can place the 
selected macro under Macro Sequence by using the Insert 
Above, Insert Below, or Replace buttons as appropriate. 

Default All Changes all of the Method Template Editor variables to their 
default values.
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Testing a Custom Template
This section provides information about testing a custom template. Use the Run Auto 
Sampler Method dialog box to enter the Methods information required for the autosampler to 
carry out autosampling. Table 8 on page 38 lists the parameters for the Run Auto Sampler 
Method dialog box. 

 To test your new template step-by-step

1. Open the Template Editor dialog box (see “To create a custom template” on page 33). 

2. Open the template to review by choosing File > Open Method Template. 

The default path to open a template is as follows: 

drive:\Thermo\Instruments\LC Devices\ThermoPAL\PAL\Methods

Variables Shows the variables that make up the macro in the Macro list. 

• Variables with specific allowed values (discrete variables) 
appear in lists. You may select the allowed values of the 
discrete variables from those presented in the list.

• Continuous variables are displayed in boxes. The allowed 
values for continuous variables appear when you hold the 
cursor over the variable’s box. You can type the value for 
the continuous variable in the box.

Buttons

Save Template Saves the Method Template under the current file name 
(overwrites the current file).

Save As Saves the Method Template under a new file name or in a new 
location that you type in the Save As dialog box.

Table 7. Template Editor page parameters (Sheet 2 of 2)

Parameter Description
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3. Under Macro Sequence, click Step to open the Run Auto Sampler Method in Step Mode 
dialog box (Figure 22).

Figure 22. Run Auto Sampler Method In Step Mode dialog box

4. Make the appropriate entries and selections as follows: 

• Under Vial Index, type an appropriate vial location for the template you are testing. 

• Under Trays, select the appropriate trays. 

• In the Injection Per Vial box, type the number of injections that you want to make 
from each vial. 

• Under Volume, type the volume that you want to inject. 

5. Click Run. 

The autosampler performs the actions specified in the template, step-by-step. At the 
completion of each step, the autosampler pauses the injection sequence and prompts you 
with the Pal Method Editor dialog box (Figure 23).

Figure 23. Pal Method Editor dialog box

6. Do one of the following:

• To continue stepping through the template, click Step. 

• To run the remaining portion of the template, click Run.

• To stop the run, click Stop Run. 
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 To run the complete sequence of macros in the template without pausing

1. Open the Template Editor dialog box (see “To create a custom template” on page 33). 

2. Open the custom template by choosing File > Template > Open Method Template.

3. Under Macro Sequence, click Run to open the Run Auto Sampler Method dialog box 
(Figure 24).

Figure 24. Run Auto Sampler Method dialog box

4. Make the appropriate entries and selections (see Table 8).

5. Click Run.

The autosampler executes the macros listed in the template. 

Table 8. Run Auto Sampler Method dialog box parameters (Sheet 1 of 2)

Parameter Description

Vial Index

1 Type the vial index to be used with the method (SL.index).

2 Type the vial index to be used with the method (SL.index2).

Trays

1 Select the tray to be used with the method (SL.tray).

2 Select the second tray to be used with the method (SL.tray2).

Injectors

1 Select the injector to be used with the method (SL.injector).

2 Select the second injector to be used with the method 
(SL.injector2).

Volume

1 Type the injection volume to be used with the method 
(SL.volume).
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Viewing the Template Summary
 To view a summary of a template

1. Open the Template Editor dialog box (see “To create a custom template” on page 33). 

2. Open the template that you want to review by choosing File > Open Method Template.

The default path to open a template is as follows:

drive:\Thermo\Instruments\LC Devices\ThermoPAL\PAL\Methods

3. Click the Template Summary tab.

The Template Summary page appears with a summary of the active template (Figure 25). 

2 Type the second injection volume to be used with the method 
(SL.volume2).

Injections Per Vial

— Type the number of replicate injections to be made from each 
vial.

Buttons

Run Run the selected method.

Cancel Cancel any changes and close the dialog box.

Table 8. Run Auto Sampler Method dialog box parameters (Sheet 2 of 2)

Parameter Description
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Figure 25. Template Summary page
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Standard Macros
Macros are the building blocks that you use to create templates. Figure 26 shows the macros 
that are provided with a standard installation. The default path to the macros is as follows: 

drive:\Thermo\Instruments\LC Devices\ThermoPAL\PAL\Macros

Figure 26. Standard macros

Using the Macro Editor to Create Custom Macros
Use the Macro Editor page of the Pal Template\Macro Editor window when you want to 
create custom macros. Table 9 on page 43 lists the parameters for the Macro Editor page. 

 To create a custom macro

1. Open the Macro Editor page as follows (Figure 27): 

a. Open the Instrument Setup window for the autosampler (see “Specifying the 
Instrument Method Parameters” on page 24). 

b. Choose Pal Auto Sampler > Template\Macro Editor. 

c. Click the Macro Editor tab. 
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Figure 27. Macro Editor page of the Template\Macro Editor window

2. Under Macro, select a macro from the list.

The description of the selected macro appears under Macro Description and a list of 
macro variables appears under Macro Variables.

3. To add a variable to the macro, do the following: 

a. Click Add to open the Variable Definition dialog box (Figure 28 on page 46). 

b. Define the variable (see “Defining Variables” on page 46).
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4. Save the macro as follows:

a. Click Save As.

b. Select a file location, and then type an appropriate name in the File Name box.

c. Click Save.

The autosampler saves the macro with the .pma file extension. 

Table 9. Macro Editor page parameters (Sheet 1 of 3)

Parameter Description

Macro This list displays existing autosampler macros. Select the 
macro that you want to edit.

Macro Description Displays a description of the selected macro.

Macro Variables

— Displays the variables used by the selected macro. 

Add Adds a new variable to the macro variables. 

For details, see “Defining Variables” on page 46. You define 
the new variable in the Variable Definition dialog box that 
opens when you click Add. In this dialog box, you can select 
the A Numeric Value or An Object option. 

• If you select a numeric variable type, you see a pane for 
entering the new variable name, a list for the variable 
units, and panes for entering the default value for the 
variable along with the lower and upper limits for the 
variable. 

• If you select an object variable type, you see a check list of 
objects that the variable might represent. 

Edit Edits an existing macro variable. 

You edit a variable in the Edit Parameter dialog box that opens 
when you click Edit. In this dialog box, you can select the 
A Numeric Value or An Object option.

• If you select a numeric variable type, you see a pane for 
entering a new variable name, a list for the variable units, 
and panes for entering the default value for the variable 
along with the lower and upper limits for the variable. 

• If you select an object variable type, you see a check list of 
objects that the variable might represent. 

Delete Deletes the selected Macro Variable.
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Command Sequence

— Lists the sequence of commands that make up the macro 
selected in the Macro list. 

When you select a command, the command parameters and 
description appear in the Command area. The command 
parameters appear in both boxes (continuous variables) and 
lists (discrete variables).

Insert Above The command shown in the Command list is inserted above 
the command selected (highlighted in blue) under Command 
Sequence.

Insert Below The command shown in the Command list is inserted below 
the command selected (highlighted in blue) under Command 
Sequence.

Replace The command selected (highlighted in blue) under 
Command Sequence is replaced by the command shown in 
the Command list.

Delete Deletes the command selected (highlighted in blue) under 
Command Sequence.

Command

— Lists the individual autosampler commands. These individual 
commands make up the command sequence of an 
autosampler macro. Select the command by moving the 
cursor over the command (no click is needed), highlighting 
each command in blue. Clicking the command displays it in 
this list (highlighted in blue). Simultaneously, the command 
parameters appear in the Parameters area below the 
Command list.

The pane below the Parameters area describes the function of 
the selected command. 

Table 9. Macro Editor page parameters (Sheet 2 of 3)

Parameter Description
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Parameters Shows the command parameters used by the selected 
autosampler command. 

• Parameters with specific allowed values (discrete 
parameters) appear in lists. You may choose the allowed 
values of the discrete parameters from those presented in 
the list. 

• Continuous parameters are displayed in boxes. The 
allowed values for continuous parameters appear when 
you hold the cursor over the respective boxes for the 
parameter. You can type the value for the continuous 
parameter in its boxes and view other allowed continuous 
parameter values in a shortcut menu. To activate this 
menu, right-click the continuous parameter box of 
interest. The parameter you select from the shortcut 
menu appears in the box. 

Command Description Shows a description of the selected command in the bottom 
pane. 

Buttons

Save Macro Saves the macro (command sequence) under the current file 
name (overwrites the current file).

Save As Saves the macro (command sequence) under a new file name, 
in a new location, or with both a new file name and location 
that you type in the Save As dialog box.

Table 9. Macro Editor page parameters (Sheet 3 of 3)

Parameter Description
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Defining Variables
Variables are the building blocks that you use to create macros. Use the Variable Definition 
dialog box to specify the details of a numerical or object macro variable that you want to add 
or edit in the Macro Variables box. Table 10 on page 47 lists the parameters for the Variable 
Definition dialog box. 

 To create custom variables

1. Open the Macro Editor page (“Using the Macro Editor to Create Custom Macros” on 
page 41). 

2. Click Add to open the Variable Definition dialog box (Figure 28).

Figure 28. Variable Definition dialog box

3. Select a variable type:

• To create a variable that is a numeric value, select the A Numeric Value option, and 
then go to step 4.

• To create an object variable, select the An Object option. A list of objects appears. Go 
to step 5.

4. Complete the definition of a numeric variable as follows:

a. In the Variable Name box, type an appropriate name.

b. In the Variable Units list, select a unit of measure.

c. In the Default Value box, type a default value for the variable.

d. In the Lower Limit box, type a lower limit for the variable.

e. In the Upper Limit box, type an upper limit for the variable.

f. Click OK to save the variable and close the Variable Definition dialog box.

5. Complete the definition of an object variable as follows:

a. In the Variable Name box, type an appropriate name. 

b. Select the appropriate objects from the list (Figure 29).

c. Click OK to save the variable and close the Variable Definition dialog box. 
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Figure 29. Object variable selections

Table 10. Variable Definition dialog box parameters (Sheet 1 of 2)

Parameter Description

Variable Type

A Numeric Value Select this option if the parameter is a numeric value. 

If you are editing an existing numerical parameter, this option 
is preselected. 

An Object Select this option if the parameter is an object. 

If you are editing an existing object parameter, this option is 
preselected. 

Variable Name If you are editing an existing variable, this box shows the 
name of the variable. If you are adding a variable, type its 
name.

OK Accepts the new Variable Definition or accepts the edits to an 
existing Variable Definition.

Cancel Deletes changes made in the Variable Definition dialog box.

 Variable Type–Numeric

Variable Units If you are editing an existing variable, this list shows the units 
for the selected variable. If you are adding a variable, you may 
enter units appropriate for that variable. When you click the 
list arrow, you can select the appropriate units from the 
options in the list. 

Default Value The nominal or center value of the variable.

Lower Limit The lowest acceptable value of the variable.

Upper Limit The highest acceptable value of the variable.
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 Variable Type–Object

Please Check What Objects 
This Variable May Be

Select the check boxes for one or more objects that the 
variable describes. 

Table 10. Variable Definition dialog box parameters (Sheet 2 of 2)

Parameter Description
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4

Using the Direct Controls to Operate the 
Autosampler

This chapter describes how to operate the Thermo PAL autosampler from the Direct Control 
dialog box that you access from the Xcalibur Instrument Setup window or from the Inlet 
Direct Control dialog box that you access from the mass spectrometer Tune application. Use 
the direct controls when you want to control the autosampler before starting a run 
acquisition.

Opening the Direct Control Dialog Box
The direct control pages for the autosampler are available from the Instrument Setup window 
and the Tune window. 

 To open the Direct Control dialog box from the Instrument Setup window

1. In the Xcalibur Instrument Setup window, click the autosampler icon. 

2. Choose Pal Auto Sampler > Direct Control to open the Direct Control dialog box 
(Figure 30). 

Contents

• Opening the Direct Control Dialog Box

• Making Single Injections from the Tune Window

• Changing the Tray Configuration

• Specifying the Location of the Direct Control Methods

• Wrapping Direct Control Injections with Additional Macros
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Figure 30. Direct Control dialog box
 

 To open the Inlet Direct Control dialog box from the Tune window

1. In the Tune window, choose Setup > Inlet Direct Control. 

2. Click the Thermo Pal tab to open the Inlet Direct Control dialog box. 

The Inlet Direct Control dialog box has the same functionality as the Direct Control 
dialog box shown in Figure 30. 

Making Single Injections from the Tune Window
You can make single injections from the Tune window by using the Methods page of the Inlet 
Direct Control dialog box. Table 11 lists the parameters for the Methods page of the Inlet 
Direct Control dialog box. 

 To make single injections from the Tune window

1. Open the Tune window for your mass spectrometer.

2. Open the Inlet Direct Control dialog box (see “Opening the Direct Control Dialog Box” 
on page 49).

3. Specify the location of the methods that you want to use by using the Direct Control 
Configuration page (see “Specifying the Location of the Direct Control Methods” on 
page 54). 
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4. Specify the tray types that are loaded in the autosampler tray holders (see “Changing the 
Tray Configuration” on page 52). 

5. Click the Methods tab. 

The Methods page appears. The Syringe area lists the size of the configured syringe. The 
Device Status area provides the status of the autosampler. 

6. In the Method list, select a method. 

A description of the method appears in the Description box. The method list depends on 
the file locations specified on the Direct Control Configuration page.

7. Make the following selections and entries: 

• Under Vial Index, type the location of the sample vial. 

• Under Trays, select the tray where the sample vial is located.

• Under Volume, type the volume that you want the autosampler to inject.

8. In the Inlet Direct Control dialog box, click the tab for the configured LC pump and start 
the solvent flow from the LC pump. 

9. Return to the autosampler Methods page, and then click Run. 

Note  The visible DLW methods in the Method list are only available if you installed 
the DLW option that comes with the autosampler. See Chapter 5, “Using Dynamic 
Load and Wash (DLW).”  

Note  The Thermo PAL autosampler only downloads the method parameters for the 
autosampler. It ignores the method parameters for the LC pump and the mass 
spectrometer. 

Table 11. Methods page parameters (Sheet 1 of 2)

Parameter Description

Method Use this list to select a method file. The visible DLW 
methods in the Method list are only available if you 
installed the DLW option that comes with the 
autosampler. 

Description Contains a description of the selected method.

Syringe Lists the size of the configured syringe. 

Device Status Displays the status of the autosampler. 
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Changing the Tray Configuration
Use the Tray Configuration page of the Direct Control dialog box to specify the tray types to 
be used for direct control injections. The autosampler uses this tray information instead of the 
tray information specified in the autosampler Control Terminal. 

Table 12 lists the parameters for the Tray Configuration page of the Direct Control dialog 
box. For information about the sample trays, see Appendix A, “Sample Trays.” 

Vial Index

1 Type the vial index to be used with the method 
(SL.index).

2 Type the second vial index to be used with the method 
(SL.index2).

Trays

1 Select the tray to be used with the method (SL.tray).

2 Select the second tray to be used with the method 
(SL.tray2).

Volume

1 Type the injection volume to be used with the method 
(SL.volume).

2 Type the second injection volume to be used with the 
method (SL.volume2).

Injectors

1 Select the injector to be used with the method 
(SL.injector).

2 Select the second injector to be used with the method 
(SL.injector2).

Injections Per Vial Type the number of replicate injections to be made 
from each vial.

Run Runs the selected method.

Table 11. Methods page parameters (Sheet 2 of 2)

Parameter Description

IMPORTANT  The autosampler does not store the tray configuration that you specify on 
the Tray Configuration page of the Direct Control dialog box. When you close the dialog 
box, the tray configuration resets to the autosampler Control Terminal settings. 
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 To temporarily change the tray configuration

1. Open the Direct Control dialog box (see “Opening the Direct Control Dialog Box” on 
page 49). 

2. Click the Tray Configuration tab to open the Tray Configuration page (Figure 31).

For information about the sample trays, see Appendix A, “Sample Trays.” 

Figure 31. Tray Configuration page (VT54 example)

3. In the Tray list, select the tray that you want to modify. 

4. In the Type list, select the tray type. 

Table 12. Tray Configuration page parameters (Sheet 1 of 2)

Parameter Description

Tray Select the tray location in the three-drawer (deep 
drawer) configuration. For information about the 
sample trays, see Appendix A, “Sample Trays.”  

Range: Tray01–Tray12

Type Select the tray type.
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Specifying the Location of the Direct Control Methods
Use the Direct Control Configuration page of the Direct Control dialog box to specify the 
location of the methods that you can open on the Methods page. Table 13 lists the parameters 
for the Direct Control Configuration page. 

 To specify the method folders

1. Open the Direct Control dialog box (see “Opening the Direct Control Dialog Box” on 
page 49). 

2. Click the Direct Control Configuration tab to open the Direct Control Configuration 
page (Figure 32). 

The default path to the methods that appear in the Method list on the Method page is as 
follows: 

drive:\Thermo\Instruments\LC Devices\ThermoPAL\PAL\DirectControlMethods

Tray Holder The allowed values are as follows:

• Stack1, for Tray01–Tra06

• CStack1, for Tray07–Tray12

Tray holders can hold one or more trays. A Stack is a 
tray holder that is designed to hold micro plates. The 
autosampler firmware determines the type and 
number. 

Vials in X Direction, 
Vials in Y Direction 

Determined by choice of tray type. 

Table 12. Tray Configuration page parameters (Sheet 2 of 2)

Parameter Description
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Figure 32. Direct Control Configuration page of the Direct Control dialog box

3. To add additional file locations, type the folder location in the Path box or click Browse 
to find the appropriate folder, and then click Add.

The new folder location appears in the box below the row of buttons.

4. To delete a file location, select the folder path, and then click Delete.

5. To reset the file location to the default folder, click Reset.

Table 13. Direct Control Configuration page parameters (Sheet 1 of 2)

Parameter Description

Wrap Each Direct Control Method Run with the Following Macros

Sequence Entry Exit Select this check box to wrap methods with the 
sequence list entry and exit macros (SLentry and 
SLexit).

Method Entry Exit Select this check box to wrap methods with the 
method entry and exit macros (Method Entry and 
Method Exit). 

Note  For more information, see Wrapping Direct Control Injections with Additional 
Macros. 

Method Search Paths

Path Type the extra path that you want to add for the 
method search routine.

Browse Use this button to search for the path to a file folder.

Add Use this button to add a file folder for the method 
search routine.

Default folder (directory) for 
the direct control methods
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Wrapping Direct Control Injections with Additional Macros
Use the Direct Control Configuration page of the Direct Control dialog box to specify 
whether the autosampler is to run the SL Entry and SL Exit, the Method Entry and Method 
Exit, or all of these macros before and after an injection. 

 To specify the use of the SL Entry and SL Exit macros 

Select the Sequence Entry Exit check box.

 To specify the use of the Method Entry and Method Exit macros

Select the Method Entry Exit check box. 

Delete Use this button to delete a file folder from the method 
search routine.

Reset Use this button to remove all of the user-added file 
folders.

[text box] Displays the file folders (directories) where the 
autosampler searches for methods.

Firmware Version Specifies the firmware version downloaded from the 
autosampler. 

Table 13. Direct Control Configuration page parameters (Sheet 2 of 2)

Parameter Description
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5

Using Dynamic Load and Wash (DLW)

This chapter describes how to use the Dynamic Load and Wash (DLW) option, which 
includes how to install the Cycle Composer Macros or ICC Cycles, how to operate the DLW, 
and a step-by-step illustration of the DLW cycles. 

Overview
This section contains an overview of the Dynamic Load and Wash (DLW) option.

The DLW option (Figure 33) represents a new wash station concept that combines an 
injection cycle with wash steps. The linked combination of the two steps, which are usually 
separate, minimizes cycle time and carryover. 

There are two characterizing features for the DLW option:

• The sample solution never contacts the syringe itself; it is held between the holding loop.

• Wash solvents are pumped from back to front into the DLW system to intensely flush all 
critical parts that are in contact with the sample.

Contents

• Overview

• Cycle Composer Macros or ICC Cycles

• Operating Dynamic Load and Wash (DLW)

• DLW Cycle Step-by-Step



5 Using Dynamic Load and Wash (DLW)
Overview

58 Thermo PAL User Guide Thermo Scientific

Figure 33. Dynamic Load and Wash (DLW)

The DLW option consists of two self-priming micro pumps (mounted on a dedicated 
bracket), and the wetted parts are Ryton™ PPS and Kalrez™ (FFPM). The pump IN ports 
connect to the wash solvent bottles and the OUT ports connect to the DLW manifold, which 
is part of the assembly of the dedicated DLW syringe holder. A holding loop separates the 
syringe from the DLW actuator to prevent sample from contacting these parts. 

The syringe and holding loop are preloaded with wash solvent #1 at the start. The sample is 
picked up and remains separated from wash solvent #1 by an air gap. After loading the loop 
and injection, wash solvent #1 is pushed into the system, followed directly by wash solvent #2 
to flush the critical valve paths. 

The DLW syringe assembly moves to the wash station for further cleaning steps and for 
preparing the syringe and holding loop for the next cycle. 

For further details, see “DLW Cycle Step-by-Step” on page 70.
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Cycle Composer Macros or ICC Cycles
You can only operate the autosampler DLW option with PAL control software, such as the 
ThermoPAL driver for the Xcalibur data system or Cycle Editor for ICC interpretation in 
another data handling system software. 

For software control, the autosampler provides three macros or three cycles. The first macro 
covers the initial and daily priming of the solvent lines and covers a complete injection cycle. 
The second macro is used for Standard speed with optimized washing possibilities. The third 
is used for a Fast cycle for optimized throughput and less focus on carryover. See Table 14.

For detailed descriptions of all macros (or cycles), see Table 15 on page 61 and Table 16 on 
page 62. 

Table 14. The DLW macro definitions

Macro name Macro description

Priming Accela Open For initial and daily routine priming of the solvent lines and DLW 
manifold. The Clean Time for both wash solvents is a variable for 
the user to define the intensity of washing.

Standard Injection 
Accela Open

Standard injection cycle using all possibilities of the DLW option. 
The injection valve inlet port and the needle are washed with both 
wash solvents (inside and out). You can add an extra Stator Wash 
for intensive washing of the injection valve (valve toggle).

Fast Injection Accela 
Open

Tuned for speed and high-throughput application. It differs from 
the Standard DLW macro in that some steps are left out to shorten 
the cycle time.

Note  The provided macros are written for standard injection valve drives, which are 
controlled and activated through the AUX interface.
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Installing the Cycle Composer Macros or ICC Cycles

The autosampler ships with a DVD containing various cycles for the DLW option. Macros 
for the Xcalibur data system are installed by the LC Devices installer. Copy these macros to 
the driver method folder or the corresponding folder for application within the integrated 
system. 

 To copy cycles to your Cycle Composer

1. Navigate in Windows Explorer to the ThermoPAL driver folder. The usual folder location 
is as follows:

drive:\Thermo\Instruments\LC Devices\ThermoPAL\PAL\

2. If you want to add the DLW option macros to an existing method folder, copy the macro 
(.pma) and the method (.pme) files from the DLW Option folder on the DVD to the 
method folder. 

If the PAL system is integrated in a data system software that controls the autosampler by 
using the Cycle Editor for PAL ICC interpretation (for example, Analyst™, 
ChemStation™, Empower™, EZChrom, MassLynx™, or Xcalibur), an ICC Cycle is used 
and not the Cycle Composer Macro. The cycle file extension is .cyx.

General Considerations

You must establish the duration of the wash steps for each configuration and application. 
Consider factors such as the viscosity and surface tension of the individual wash solvent 
composition and the backpressure of the system.

Be aware that a higher backpressure builds up if the valve bore size (standard valve bore 
0.25 mm) or the installed loop internal diameter is lower. Standard loop internal diameter 
(ID) for Thermo-defined loops with a volume of 5, 10, and 20 μL is 0.25 mm. The loop with 
2 μL content volume has an ID of 0.125 mm.

Keep the tubing internal diameters of the tubing in line with the valve dimensions, loop ID, 
and flow rate. 

Tip  You can convert a Cycle Composer macro to a cycle (extension .cyx) by using the 
Cycle Editor software. Conversion is available starting with Cycle Editor version 
1.4.0.4. 
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Priming the Solvent Lines, Wash1 and Wash2

Use this macro at installation to prime the entire system. Set the wash time to approximately 
120 seconds for each solvent.

After installation, for best results prime the system before activating the first run. For daily 
preparation of the system, the wash time can be much shorter: approximately 20 seconds. The 
goal is an entire liquid system free of any air bubbles.

 To prime the solvent lines

1. Set the wash time to approximately 120 seconds for each solvent. 

2. After installation, for best results prime the system before activating the first run. For 
daily preparation of the system, the wash time can be much shorter: approximately 
20 seconds. The goal is an entire liquid system free of any air bubbles.

Table 15 describes the function of the Priming Accela Open AS_Rev01 macro.

Table 15.  Priming Accela Open AS_Rev01 macro (Sheet 1 of 2)

Macro description Macro variable

The injection unit moves to the DLW Wash 
Station, position Wash1.

Clean Time solvent 1
Eject Speed DLW Syringe

The injection unit moves to the DLW Wash 
Station, position Wash2.

Clean Time solvent 1
Eject Speed DLW Syringe

The DLW system is rinsed with Wash 
Solvent 1 in position Waste. 

—

The injection valve is cleaned first with the 
content of the DLW syringe (Wash 
Solvent 1), followed by Wash Solvent 2 and 
finally, the last wash to prepare the system 
for an injection cycle, rinsed with Wash 
Solvent 1 again.

Remark: The Atom Rinse Inj is new, 
available starting with FW 4.1.x. The DLW 
actuator/solenoid is activated; the Wash 
Solvent (pump), the Needle Gap, and the 
Rinse Time are selectable. 

Needle Gap is a parameter from Rinse Inj 
Atom. The variable in this macro is Needle 
Gap Valve Clean.

The function of this parameter is to 
minimally raise the needle in the injection 
port to allow rinsing around the needle tip. 

The pressure of the spring-loaded balls in the 
DLW Syringe Holder assembly is released by 
moving approximately 3 mm up (default). 
This leaves a gap, between the needle tip and 
the valve bottom, of approximately 1 mm to 
enable a flush at this contact point. 

A Repeat-End loop enables adding an extra 
rinsing step, valve toggle. 

Stator Wash: 
Counter 0 = disable valve toggle steps
Counter 1 = enable valve toggle steps
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Standard DLW Injection Cycle

Table 16 describes the function of the Stand Injection Accela Open macro.

If the counter is set to 1, follow the described 
steps below. If the counter is set to 0, the 
macro finishes at this point.

—

The injection moves to the injection valve.
The valve is switched to the Active position.

—

The valve is rinsed with Wash Solvent 2, 
followed by Wash Solvent 1.

Stator Wash Time Solvent 2
Stator Wash Time Solvent 1

Remark: The loop is filled with the last rinse 
of Wash Solvent 1. Verify the composition of 
Wash Solvent 1. The solvent should have a 
lower elution power than the solvent 
gradient starting conditions or sample 
solvent composition. This is important for 
partial loop filling. 

The injection valve is switched back to the 
Standby position.

—

End of macro DLW Priming. —

Table 15.  Priming Accela Open AS_Rev01 macro (Sheet 2 of 2)

Macro description Macro variable

Table 16. Stand Injection Accela Open macro parameters (Sheet 1 of 3)

Macro description Macro variable

The PAL system waits first for the Sync 
Signal Ready before the injection cycle starts.

Remark:
Sync Signal setting Start

The injection valve moves to a defined 
Standby position.

Inject to 
Standby

The Rear air segment pulls into the Holding 
Loop.

Airgap Volume 
Filling Speed

The sum of Rear-, Sample List-, and 
Front-Volume aspirates into the Holding 
Loop. 

The Front air segment aspirates.

Front Volume
Rear Volume
(SL.volume)

Airgap Volume
Filling Speed
Pullup Delay
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The injection unit moves to the DLW Wash 
Station, Wash1 position.

The needle is inserted (dipped) for 1 second 
to wash the outer needle surface. No plunger 
movement at this step.

—

The injection unit moves to the specified 
injection valve.
The Front- and Airgap-Volume is ejected.

Inject to
Front Volume
Airgap Volume
Injection Speed

The PAL system waits for the data system. Wait for DS

The injection valve switches to Active 
position.
Wait the Pre Inject Delay time.

Inject to
Pre Inject Delay

The loop fills with the sample volume as 
specified in the Sample list.

(SL.volume)
Injection Speed

The injection valve switches to Standby 
position, the loop content is injected.
Timer  Delay Stator Wash starts and sends a 
Start signal to the HPLC system.

Post Inject Delay

Timer 1

The plunger of the DLW Syringe moves 
down to dispense the Rear Sample and Air 
Segment to Waste. The Holding Loop is still 
filled with Wash Solvent 1.

(Syr. Eject Speed)

The DLW Actuator/Solenoid activates to 
deliver Wash Solvent 2 into the Holding 
Loop to clean the injection valve from Port 1 
to Port 2.

For this step the needle tip is lifted, releasing 
the sealing pressure to enable rinsing around 
the tip sealing point.

Wash2
Inject to
Needle Gap Valve Clean
Valve Clean Time Solvent 2

The injection unit moves to the DLW Wash 
Station, Wash2 position.

The needle is rinsed inside and out with 
Wash Solvent 2. 

Wash2
(Syr.Eject Speed)

Post Clean Time Solvent2

Table 16. Stand Injection Accela Open macro parameters (Sheet 2 of 3)

Macro description Macro variable
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The injection unit moves back to the 
injection valve. The Inlet Port and engraving 
to waste Port are flushed with Wash Solvent 
1 to prepare the valve for the next injection.

Wash1
Inject to
Needle Gap Valve Clean
Valve Clean Time Solvent 1

The injection unit moves back to the DLW 
Wash Station, Wash1 position to flush the 
syringe needle inside and out with Wash 
Solvent 1.

This is a preparation step for the next 
injection, and especially important for 
biofluid samples.

Wash1
Post Clean Time Solvent 1

Cycle end for LC-Inj DLW Standard macro. —

An optional cleaning step is attached to the 
DLW Standard injection cycle: Stator Wash 
or valve toggle.

A Repeat-End loop can be activated with the 
Count.

Stator Wash
Stator Wash count: 1 = Cleaning step active
Stator Wash count: 0 = Cleaning step 
disabled

If Stator Wash is activated, the following 
steps are executed.

—

The injection unit moves to the injection 
valve. From the last step above, the Holding 
Loop is filled with Wash Solvent 1. 

Timer 1 waits to switch the valve (Toggle) 
into Active position (fill loop). 

Inject to
Delay Stator Wash
(Active)

The DLW Actuator/Solenoid activates to 
deliver Wash Solvent 2 to the Holding Loop 
and into the valve system.

The first solvent flush arriving at the valve is 
Wash Solvent 1 parked in the Holding Loop 
at the beginning, followed by Wash 
Solvent 2.

Inject to
Wash2
Stator Wash Time Solvent 2

Wash Solvent changes to Wash Solvent 1. Inject to
Wash1
Stator Wash Time Solvent 1

The injection valve switches back to the 
Standby position.

Inject to
(Standby)

Table 16. Stand Injection Accela Open macro parameters (Sheet 3 of 3)

Macro description Macro variable



 5 Using Dynamic Load and Wash (DLW)
Cycle Composer Macros or ICC Cycles

Thermo Scientific Thermo PAL User Guide 65

Fast DLW Injection Cycle

The Fast injection cycle differs from the Standard cycle as follows:

• The needle is not dipped in the Wash station Wash1 after sample pickup and before it 
moves to the injection valve.

• The wash steps after injection are reduced to Valve Clean with Wash Solvent 1 and Wash 
Solvent 2. The DLW needle is flushed in the DLW Wash Station with Wash Solvent 1 
only.

• Stator Wash (valve toggle) is not available.

Table 17 describes the function of the Fast Injection Accela Open macro.

Table 17. Macro Fast Injection Accela Open (Sheet 1 of 2)

Macro description Macro variable

The PAL system waits first for the Sync 
Signal Ready before the injection cycle starts.

Remark:
Sync Signal setting Start

The injection valve moves to a defined 
position: Standby.

Inject to
Standby

The Rear air segment aspirates into the 
Holding Loop.

Airgap Volume
Filling Speed

The sum of Rear-, Sample List-, and 
Front-Volume aspirates into the 
Holding Loop.

The Front air segment aspirates.

Front Volume
Rear Volume
(SL.volume)
Airgap Volume
Filling Speed
Pullup Delay

The injection unit moves to the specified 
injection valve.
The Front- and Airgap-Volume ejects to 
Waste.

Inject to
Front Volume
Airgap Volume
Injection Speed

The PAL system waits for the data system. Wait for DS

The injection valve switches to Active 
position.
Wait the Pre Inject Delay time.

The loop fills with the sample volume as 
specified in the sample list.

The injection valve switches to Standby 
position, and the loop content is injected.

Inject to

Pre Injection Delay

(SL.volume)

Injection Speed
Post Inject Delay
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Operating Dynamic Load and Wash (DLW) 
This section describes how to operate the Dynamic Load and Wash (DLW) option.

• Priming the Solvent Lines

• Location of Solvent and Waste Bottles

• DLW Pumps

The plunger of the DLW Syringe moves 
down to dispense the Rear Sample and Air 
Segment to Waste. The Holding Loop is still 
filled with Wash Solvent 1.

Injection Speed

The DLW Actuator/Solenoid activates to 
deliver Wash Solvent 2 into the Holding 
Loop to clean the injection valve from Port 1 
to Port 2.

For this step the needle tip is lifted, releasing 
the sealing pressure to enable rinsing around 
the tip sealing point.

Inject to
Wash2
Needle Gap Valve Clean
Valve Clean Time Solvent 2

Wash Solvent 1 follows to prepare the valve 
for the next injection.

Wash1
Inject to
Needle Gap Valve Clean
Valve Clean Time Solvent 1

The injection unit moves back to the DLW 
Wash station, Wash1 position to flush the 
syringe needle inside and out with Wash 
Solvent 1.

This is a preparation step for the next 
injection, and is especially important for 
biofluid samples.

Wash1
Post Clean Time Solvent 1

Cycle ends for LC-Inj DLW Fast macro. —

Table 17. Macro Fast Injection Accela Open (Sheet 2 of 2)

Macro description Macro variable
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Priming the Solvent Lines

To make the initial and daily priming efficient and controllable, the Open autosampler comes 
with a Cycle Composer macro, or ICC cycle.

 To prime the solvent lines

1. Load the macros and methods into the folder.

2. Start the corresponding macro for initial or daily priming.

3. Check the solvent lines and prime until air bubbles are no longer visible.

4. Press F4 for Home.

Location of Solvent and Waste Bottles

The DLW option contains self-priming membrane pumps. You can place the solvent bottles 
either in the fast wash station holder or on the lab bench. 

You must place the Waste bottle greater than 30 cm (11.8 in.) below the injection valve. Make 
sure that the waste liquid can flow into the waste bottle without restriction. Place the waste 
tubing above the level of the liquid. Ideally, the tube is fixed at the neck of the waste bottle.

Tip  For trouble-free DLW operation, make sure the two solvent lines are free of air 
bubbles at all times. If the solvent lines are being connected for the first time or during a 
solvent change, you must prime the solvent lines properly until air bubbles are no longer 
visible. Use solvent degassing for best results.

Tip  Use good laboratory practice to avoid contaminating the wash solvents and the wash 
bottles. Avoid biological growth in pure water by either replacing it regularly or adding a 
small percentage of organic solvents, such as methanol or acetonitrile. Certain buffer 
solutions can decompose at room temperature when exposed to light. Filtering the wash 
solvents before filling the bottle, especially if using salt buffers, is mandatory to avoid any 
clogging of the solvent paths.
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DLW Pumps

From the control point of view, the DLW pumps respond in the same manner as the fast wash 
station. Power-out signals activate the pumps. Because the electric current setting for the 
DLW is different, you must load the corresponding PAL Firmware Objects for the DLW wash 
station type.

The wetted parts in the pump are made from the following materials:

• Membrane: Kalrez (FFPM)

• Body, valves: Ryton PPS

The pumps are self priming with a maximum suction lift of a 3 m column of water.

DLW Actuator/Solenoid

The DLW Actuator/Solenoid has the function of separating and completely shutting off the 
lines in the direction of the syringe (sample loading) or the wash solvent lines. 

After opening the DLW Actuator/Solenoid for the wash solvent lines, you can pump the 
desired wash solvent into the system by activating the corresponding DLW pump.

Figure 65 on page 100 illustrates this functionality as part of the step-by-step cycle for a 
standard injection.

The wetted parts in the DLW Actuator Solenoid are made from the following materials:

• Solenoid body: PEEK™

• Seal material: FFKM (Simriz™)

Figure 34 shows the DLW manifold and the actuator/solenoid connections. Figure 35 shows 
the DLW flow diverter being inserted. 

Note  PEEK exhibits excellent chemical resistance to most of the chemicals used. 
However, the following solvents are not recommended for use with PEEK: DMSO, THF, 
methylene chloride (dichloromethane), nitric acid, or sulfuric acid. For more details, refer 
to the compatibility tables provided by the manufacturer of PEEK material or 
components.

Note  Current applied from the actuator control PCB to the actuator/solenoid activates a 
green LED. This activation does not indicate that the solenoid opens or closes. 



 5 Using Dynamic Load and Wash (DLW)
Operating Dynamic Load and Wash (DLW)

Thermo Scientific Thermo PAL User Guide 69

Figure 34. DLW manifold and Actuator/Solenoid

Figure 35. Inserting the DLW Flow Diverter
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DLW Cycle Step-by-Step
This section provides illustrations to demonstrate a step-by-step DLW cycle.

• Cycle for Standard Injection

• Additional Valve Toggle Step to DLW Standard Cycle

• Cycle for Fast Injection

Cycle for Standard Injection

Figure 36 to Figure 49 illustrate a step-by-step cycle for the standard injection.

Figure 36. Standard: Start the cycle



 5 Using Dynamic Load and Wash (DLW)
DLW Cycle Step-by-Step

Thermo Scientific Thermo PAL User Guide 71

Figure 37. Standard: Step 1 – Aspirate rear air segment
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Figure 38. Standard: Step 2 – Get sample and aspirate rear, inject, and front volume
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Figure 39. Standard: Steps 3 - 4 – Aspirate front air segment
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Figure 40. Standard: Steps 5 - 6 – Insert the needle in wash position 1 to clean the outside
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Figure 41. Standard: Steps 7 - 8 – Dispense front air segment and front sample volume to waste
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Figure 42. Standard: Steps 9 - 10 – Switch valve to LOAD position and fill loop with inject volume
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Figure 43. Standard: Step 11– Switch valve to INJECT position and start chromatographic process
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Figure 44. Standard: Step 12 – Dispense rear sample volume and air segment to waste
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Figure 45. Standard: Steps 13 - 14 – Clean valve with Wash Solvent 2
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Figure 46. Standard: Steps 15 - 16 – Wash the syringe needle with Wash Solvent 2
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Figure 47. Standard: Steps 17 - 18 – Clean valve with Wash Solvent 1
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Figure 48. Standard: Steps 19 - 20 – Wash the syringe needle with Wash Solvent 1



 5 Using Dynamic Load and Wash (DLW)
DLW Cycle Step-by-Step

Thermo Scientific Thermo PAL User Guide 83

Figure 49. Standard: End cycle
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Additional Valve Toggle Step to DLW Standard Cycle

This section contains information about additional steps that are necessary for a DLW 
Standard Cycle.

Considerations for Additional Stator Wash Cleaning Step

The DLW Standard Cycle has the built-in option for the user to switch the injection valve at 
the end of the chromatographic run before equilibration of the column to the start 
conditions. 

If the method variable “Stator Wash” is set to “1,” the extra cleaning process for the valve, with 
“Valve Toggle,” is part of the standard cycle. 

If the method variable is deactivated (setting “0”), the DLW Standard cycle ends as shown in 
Figure 49 on page 83.

The macro (cycle) is written such that the optional valve toggle steps can be executed before 
re-equilibration of the column. You must synchronize the time to switch the valve with the 
chromatographic method by using the method variable Delay Stator Wash. The two wash 
solvents are timed by the method variables, Stator Wash Time Solvent 1 and Stator Wash 
Time Solvent 2. After these wash times have elapsed, the valve switches back to the start 
position.

Figure 50 illustrates the recommended retention time for Stator Wash or Valve Toggle times.

Figure 50. Timing for Stator Wash Step

From a chromatographic viewpoint, the optional cleaning step is important to understand. 
Assuming that the valve stator between ports 1 and 6 (for example, in the standard 
Cheminert™ valve) is contaminated and cannot be cleaned during the injection process, the 
valve toggle brings the engraving back between the two ports. Flushing the valve with both 
wash solvents eliminates remaining sample material located between stator ports 1 and 6.
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What points must you consider when you use the Stator Wash or Valve Toggle option?

Observe the rules if biofluid samples are injected. First, sample contact should always be with 
an aqueous solution to avoid protein precipitation. After washing with organic solvent (higher 
elution power), flush the system again with wash solvent 1.

The first toggle near the end of the chromatographic cycle provides the advantage that the 
sample loop is already flushed out first with the mobile phase with a solvent of high elution 
power (assuming gradient application).

The second valve toggle time follows immediately after finishing the second solvent flush. You 
cannot program a second switching time. The waiting time for the second valve toggle should 
be long enough so that the entire system is flushed out by both wash solvents.

Consider the entire delay volume to determine the second valve switch. The DLW internal 
volumes are as follows: 

Manifold, 90 μL 
Holding Loop,108 μL 
Syringe Needle Gauge 22, 6.7 μL 
Installed Injection Loop

Total delay volume: 205 μL + Loop content volume

Do the second valve toggle (back to starting condition) before the system equilibration time 
has started. The Loop content is ideally a solvent of a low elution power when switched back. 

If you apply isocratic chromatography, the remaining contaminants might be washed into the 
system and can build up higher background noise for the column, the detector, or both over a 
longer period of time.
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Additional Cleaning by Using the Stator Wash or Valve Toggle

Figure 51 to Figure 56 illustrate additional cleaning steps for “Stator Wash.”

Stator Wash: End of Standard Injection Cycle
Figure 51. Start the additional Valve Toggle cleaning step 
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Figure 52. Stator Wash: Step 1 - 2 – Switch valve to Load Position (toggle) and clean valve with 
Wash Solvent 1
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Figure 53. Stator Wash: Step 3 – Clean valve with Wash Solvent 2
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Figure 54. Stator Wash: Step 4 – Wash Solvent 1 dispenses Wash Solvent 2
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Figure 55. Stator Wash: Step 5 – Wash Solvent 1 cleans second valve 
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Figure 56. Stator Wash: Step 6 – Switch valve back to Inject Position (toggle)
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Cycle for Fast Injection

Figure 57 to Figure 68 illustrate a step-by-step cycle for the Fast Injection.

Figure 57. Fast: Cycle starts
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Figure 58. Fast: Step 1 – Aspirate rear air segment
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Figure 59. Fast: Step 2 – Get sample and aspirate rear, inject, and front volume
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Figure 60. Fast: Step 3 - 4 – Aspirate front air segment
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Figure 61. Fast: Steps 5 - 6 – Dispense front air segment and front sample volume to waste
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Figure 62. Fast: Steps 7 - 8 – Switch valve to LOAD position and fill loop with Inject Volume
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Figure 63. Fast: Step 9 – Switch valve to INJECT position and start chromatographic process
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Figure 64. Fast: Step 10 – Dispense rear sample volume and air segment to waste
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Figure 65. Fast: Steps 11 - 12 – Clean valve with Wash Solvent 2



 5 Using Dynamic Load and Wash (DLW)
DLW Cycle Step-by-Step

Thermo Scientific Thermo PAL User Guide 101

Figure 66. Fast: Steps 13 - 14 – Clean valve with Wash Solvent 1
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Figure 67. Fast: Step 15 – Wash the syringe needle with Wash Solvent 1
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Figure 68. Fast: End cycle
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A

Sample Trays

This appendix describes the nomenclature for the stack number, tray location number, and 
sample start location number. 

For more information about the trays, refer to the Accela Open Autosampler Hardware Manual. 

Note  You must use the handheld Control Terminal to specify the stack, tray location, and 
sample start numbers. 

Contents 

• Tray Types 

• Tray Position 

• Sample Position 
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Tray Types
Figure 69 through Figure 72 show the tray types for use in the Thermo PAL autosampler. 

Figure 69. Tray type VT54 

Figure 70. Tray type MT96 

54-position, vial tray (9 × 6) 

96-position, standard shallow micro plate (12 × 8) 
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Figure 71. Tray type DW96 

Figure 72. Tray type MT384 

96-position, deep well micro plate (12 × 8) 

384-position, high-density shallow micro plate
(24 × 16) 



A Sample Trays
Tray Position

108 Thermo PAL User Guide Thermo Scientific

Tray Position
The nomenclature for the stack, tray, and sample positions is as follows: 

CStk1–TT:SS 

Where: 

• CStk1 refers to the first stack cooler, which contains multiple tray drawers. (The 
designation for a second stack cooler is CStk2.) 

• TT is the tray position within the overall stack. Figure 73 shows the six tray positions, 
numbered 01 through 06, for a three-drawer stack. 

Figure 73. Tray positions in a stack cooler with three drawers 

• SS is the sample position within the designated tray. For examples, see Table 18 and the 
formula that follows the table. 

Position 02
(back)

Position 01
(front)

 04

03

 06

05

Front of drawer

Top drawer

Middle drawer

Bottom drawer
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Sample Position
For the 54-position tray, use the marked numbers on the tray to specify the sample start 
location. For the 96-position well plates, use the position numbers listed in Table 18. For the 
384-position well plate, use the formula that follows the table to calculate the sample start 
position number. 

Table 18. Position numbers for the 96-position (12 × 8) micro plate

A-B No. B-C No. C-D No. E-F No. F-G No. G-H No. 

A1 1 B5 17 C9 33 E1 49 F5 65 G9 81

A2 2 B6 18 C10 34 E2 50 F6 66 G10 82

A3 3 B7 19 C11 35 E3 51 F7 67 G11 83

A4 4 B8 20 C12 36 E4 52 F8 68 G12 84

A5 5 B9 21 D1 37 E5 53 F9 69 H1 85

A6 6 B10 22 D2 38 E6 54 F10 70 H2 86

A7 7 B11 23 D3 39 E7 55 F11 71 H3 87

A8 8 B12 24 D4 40 E8 56 F12 72 H4 88

A9 9 C1 25 D5 41 E9 57 G1 73 H5 89

A10 10 C2 26 D6 42 E10 58 G2 74 H6 90

A11 11 C3 27 D7 43 E11 59 G3 75 H7 91

A12 12 C4 28 D8 44 E12 60 G4 76 H8 92

B1 13 C5 29 D9 45 F1 61 G5 77 H9 93

B2 14 C6 30 D10 46 F2 62 G6 78 H10 94

B3 15 C7 31 D11 47 F3 63 G7 79 H11 95

B4 16 C8 32 D12 48 F4 64 G8 80 H12 96
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Use the following formula to calculate the sample position number: 

N = ([Row – 1] × W) + Col 

Where: 

• N is the calculated sample position number in the tray. 

• Row is the sample’s row converted to a number. 

A equals 1, B equals 2, C equals 3, and so on. 

• W is the total number of columns on the tray: 

– Equals 12 for the 96-position tray 

– Equals 24 for the 384-position tray 

• Col is the sample’s column number: 

– Equals 1 to 12 for the 96-position tray 

– Equals 1 to 24 for the 384-position tray 

The following example is for the sample position C22 in a 384-position micro plate: 

N = ([3 – 1] × 24) + 22 = 48 + 22 = 70 
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Index

A
autosampler control terminal, using  21

C
cables

DB9 to DB9 serial cable  4
external contact trigger cable  12
PAL interface cable  12
Thermo Dual Configuration cable  10
Thermo Single Configuration cable  6

compliance
FCC  iii
regulatory  iii

compliance, WEEE  v
computer requirements  xi
contact closure connections

for a Thermo Scientific LC pump  7
for a Thermo Scientific MS  7
for an Agilent pump  12
for two Thermo Scientific pumps  10

contacting us  xiii
control terminal attached to the autosampler  21
cycle composer macros  59
cycle composer macros or ICC cycles, installing  59
Cycle Editor  59

D
delay time  28
device drivers  xi
Direct Control Configuration page  54
Direct Control dialog box, opening  49
DLW

characterizing features  57
cycle  70
cycle for fast injection  92
cycle for standard injection  70
fast injection cycle  65

macro definitions  59
operating  66
overview  57
priming solvent lines  61
standard injection cycle  62

DLW Actuator/Solenoid  68
DLW Pumps  68
documentation

accessing  x
additional  x
online  xiv
survey  xiv

E
electromagnetic compatibility  iii
EMC compliance  iii
equation, sample position number in tray  110
error message, server failure  xi
external contact board for Agilent pump  12
external contact closure cable connections  7

F
FCC compliance  iii
file types

instrument methods (.meth)  28
macro (.pma)  43
templates (.pme)  34

I
ICC cycles  59
Injected screen on hand-held controller  23
Inlet Direct Control, opening  50
Instrument Configuration window  17
Instrument Setup window, opening  25
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Index: J

J
Job Queue screen  22

L
level surface, importance of  2
lithium battery  1

M
Macro Editor

enabling  19
opening  41
page parameters  41

Macro, Instrument Setup  30
macros

creating  41
cycle composer  59
importing  19
list of standard  41

mass spectrometry applications  ix
Menu screen  22
method parameters, specifying  25
method templates, list of  26

N
nomenclature for stacks, trays, and samples  105
numeric variables  46

O
object variables  46
ordering information  2
output signal to LC pump  5

P
parameters

Direct Control
Method page

Description  51
Device Status  51
Injections Per Vial  52
Injectors  52
Method  51
Syringe  51
Trays  52
Vial Index  52
Volume  52

Tray Configuration page
Tray  53
Tray Holder  54
Type  53

Vials in X Direction  54
Vials in Y Direction  54

Instrument Configuration  20
Auto Select  20
Browse  21
Check  20
Com Port  20
Enable  20
Import  21
Import Path  21
Overwrite Existing Macros  21
Stack  21
Tray Name  21

Instrument Setup
Browse  29
Delay Time  30
Macro Sequence  29
Method Folder  29
New Template  29
Syringe  29
Template  29
Template Description  29
Variables  30
Volume  30

Macro Editor page
Add  43
Command  44
Command Description  45
Command Sequence  44
Delete  43–44
Edit  43
Insert Above  44
Insert Below  44
Macro  43
Macro Description  43
Macro Variables  43
Parameters  45
Replace  44

macros
Fast Injection Accela Open  65
Priming Accela Open AS_Rev01  61
Stand Injection Accela Open  62

Run Auto Sampler Method dialog box
Injectors  38
Trays  38
Vial Index  38
Volume  38

Template Editor page  33
Variable Definition dialog box

A Numeric Value  47
An Object  47
Default Value  47
Lower Limit  47
Upper Limit  47
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Variable Name  47
Variable Units  47

part numbers  2
priming solvent lines  61
pulse time of the out signals, setting  24
pumps, self-priming  58

R
Recommended Injection Volume box  28
regulatory compliance  iii
release notes  xi
requirements

computer  xi
software  xi

Run Auto Sampler Method dialog box parameters  36

S
safety information  1
safety standards  iii
sample trays  105
self-priming micro pumps  58
server failure error message  xi
software requirements  xi
solvent lines, priming  61, 67
stack, cooler  108
survey link  xiv
syringe size, specifying  28
system requirements  xi

T
Template Editor

enabling  19
opening  33

Template Editor page parameters  33
templates

editing  33
Single Step LC Injection  26
testing  36

Thermo PAL driver for Xcalibur  59
Tray Configuration page  53
tray type, selecting with the PAL Control Terminal  22
Trays  38
trays

position in stack  108
sample position  109
type

DW96  107
MT384  107

MT96  106
VT54  106

Trays screen  22
Tune window, making single injections from  50

V
variables, defining  46

W
Waiting for contact closure status for LC pump  23
WEEE compliance  v
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